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ABSTRACT 

 

 

 

 

This Independent Learning Project (ILP) discusses the best practices in educational 

technology to improve the behavior, instruction, and learning of at-risk youth, for whom 

technology offers unique opportunities. Research is compiled from numerous scholarly 

print and online sources.  A guide for teachers provides detailed strategies, software 

tutorials and specific resources for integrating technology into the curriculum.  
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CHAPTER I  

 

 

Introduction  

 

I became interested in the problems of at-risk youth when I began to work at a 

behavioral high school for special needs students in 2001. With compassion and empathy 

learned from my own disadvantaged childhood, I now provide education, counseling and 

support services to adolescents with learning disabilities and behavioral disorders. I also 

became aware that, regardless of what is going on at home; school is a safe place which 

can provide support for these students.  

Stereotyping is an enormous issue for these youth; too often they are labeled 

incorrectly. There is a considerable amount of literature on who is at- risk, however these 

students are not all born at-risk. They are influenced by their environment, their families, 

community, problems with peers, and society in general. Stereotyping should be avoided; 

educators must look at each student as an individual. Being stereotyped by others can be 

difficult and painful for these students. When we make assumptions based on limited 

information we are opening the door to injustice.  

Stereotyping makes the students feel judged, they become angry and frustrated, which 

only leads to poor behavior and low performance on school work. Teachers must be 

culturally responsive to their studentsô needs, to assume that ñall poor kids do not 

perform wellò or that ñgirls are not good at math and scienceò only discourages students 

(Bombardieri, 2005). We need to raise our expectations, not lower them. We need to let 

the students know that they are here to learn, and that their abilities can improve with 

hard work.  



There are a great number of factors that lead to these students acquiring the label at-

risk. However, these students are resilient, they set goals, they look forward to their 

futures, they learn, and they are survivors. We need to ask in what ways youth are at-risk, 

not just if they are at-risk. Then teachers need to creatively use the solutions that are 

available for their studentsô problems. 

The assumption that these students can not learn, is just that; an assumption. They do, 

and can, learn.  We need to understand and care for these youth, as we do all youth. We 

need to help these youth build their self-esteem, self-confidence and give them a sense of 

responsibility.  They may lead one to think that they do not care, but in reality, they do 

care. They are looking for teachers who will not give up on them, teachers who will make 

an effort to understand them, and teachers who believe in them. They are no different 

from any other youth. I can't change the past of the youth I work with, but I can affect 

what happens when I am with them. In that way, I can make a difference.  

This research will benefit everyone who works with the at-risk population. The 

solutions are not as complicated as one may think. Research has shown that one needs to 

have an open mind when dealing with these youth. One needs to be aware of and utilize 

the multiplicity of educational approaches already available. This approach, of course, is 

supported by Howard Gardner's concept of multiple intelligences (Gardner, 1983). 

Gardner believes there are at least eight intelligences (verbal-linguistic, logical-

mathematical, visual-spatial, musical-rhythmic, kinesthetic-movement, interpersonal, 

intrapersonal, and environmental). Research conducted with learning disabled and 

emotionally disturbed students indicates that their achievement levels are greater with 

computer assisted instruction, than with conventional instruction alone (Cotton, 1991). 



Teachers of at-risk youth need to become more aware of the enormous assets these 

new technologies can bring to their classroom, and in their curriculum. The use of on-line 

technologies such as e-mail, chat rooms, instant messaging, online gaming, and social 

networking has increased at an incredible rate. These do not need to be seen as only 

potential distractions. Adults have become the digital immigrants as the students advance 

in their knowledge of todayôs technology.  It is the responsibility of teachers to learn how 

to use this technology for their studentsô educational benefit.  

The goal of this project is to present to educators the importance of fully integrating 

technology into the curriculum of at-risk students.  At-risk students can learn, and there 

are evidence based practices available such as Universal Design for Learning, Intel Teach 

Program and software programs such as, Inspiration, Kidspiration, Write: OutLoud, the 

award-winning talking word processor by Don Johnson, and Kurzweil 3000, a Windows-

based reading, writing and learning software for struggling students.  

This project will make educators aware of different solutions to working with the at-

risk population. There are many great teachers across the country doing impressive work 

with these youth. Information technology alone has opened up the world to these 

students; the Internet has provided these youth with experiences to which they may never 

have been exposed.  Information technology has become one of the most important tools 

in education. The Internet is growing at an astonishing speed and todayôs youth are 

communicating with each other in new and different ways. Educators need to keep up 

with the new tools of the 21
st
 century. 

Teachers play an especially important role in these studentsô lives. We can gain the 

studentsô trust by being consistent, by being positive role models, and by providing the 



structure so many at-risk youth lack in their lives. We need to maintain healthy 

boundaries when working with this population of youth. All children can learn; schools 

and teachers can make a difference. Immediate gains are possible when the best practices 

available are used. Specific classroom strategies can increase student achievement.  

Statement of the Problem 

 

 The lack of teacher commitment to integrating technology into the curriculum of 

at-risk youth is a problem; many teachers do not feel confident or comfortable using 

computers. Instructional technology can support learning and aid in the delivery of 

instruction to these students, and integrating technology into the curriculum can improve 

student achievement. Educators must incorporate technology into all aspects of teaching, 

learning, and assessment.   

 Far too often, it has been observed that the technology is being used ineffectively. 

Educators need to invest the time necessary to learn the tools of the 21st century. Lack of 

training, fear of the unknown, and no support are a few excuses that are voiced by 

teachers in defending their case for not using technology in their lesson planning. 

Todayôs at-risk youth are not going away, and computer assisted instruction can enhance 

learning in demonstrable ways. 

 The Massachusetts Recommended K-12 Instructional Technology Standards 

states that ñBecoming proficient in technology will enable students to enhance their 

learning and prepare themselves for the increasingly competitive world beyond schoolò 

(Massachusetts Department of Education, 2007 p 1). The research shows that the at-risk 

youth need to focus on transition from school to work; educators need to better prepare 

students for the work force. School-to-work transition helps at-risk youth secure and 



maintain employment, todayôs employers are looking for tech savvy employees. Todayôs 

workforce requires greater education and computer skills.  

The use of computers as a babysitter is not an efficient use of the resource. 

Teachers need to develop appropriate lesson plans or not use computers at all. This truly 

demands collaboration. Todayôs youth have embraced technology with such things as the 

PC (Personal Computer), the Internet, cell phones, and Ipods.  However, there needs to 

be structure and constant guidance to be able to use these educational technologies 

effectively. 

 Educators must familiarize themselves with the technology to better prepare their 

students to enter the world after graduation. They must continuously monitor student use 

and assess their progress as they would with any other traditional classroom instruction. 

Are students using the technology to support their learning; or are they using it to replace 

their learning?  

 Another part of the problem is the lack of time for teachers to participate in 

professional development programs for integrating technology into their curriculum. 

School administrators are not familiar enough with what it takes to integrate this 

technology. There must be plans put in place to find funding and time for professional 

development, these plans must also be implemented. The plan should be reviewed 

annually to monitor new technologies and to integrate them into the curriculum.  

 We are teaching the information generation. We must understand that technology 

is part of todayôs youth culture. We must not only recognize technology's promise, but 

also the magnitude of power it has in the hands of todayôs at-risk youth. This project will 



investigate how teachers can learn to empower at-risk youth through the use of 

technology as a learning tool.  

Rationale 

 

The purpose of this Independent Learning Project will be to research the wealth of 

information related to using technology to facilitate quality education for the 

Neomillennial learning styles of todayôs youth. Digital media encourages multitasking. 

Todayôs youth do  homework while simultaneously reading, listening to a MP3 player, 

receiving and sending e-mail, and dialoguing with classmates via instant messaging. 

Since they were young, they have been bombarded by technical stimulus (Dede, 2005).  

My research will focus on the tools available to teach at-risk learners in the 21st 

Century. Todayôs youth are digital learners; they are easily bored and unmotivated by 

traditional teaching practices. One of the first things a teacher must consider is that each 

student has a different learning style. Bloomôs taxonomy demonstrates different styles of 

learning related to cognitive domain (Huitt, 2004). Technology has opened up a new 

world to todays at- risk youth. Problem based learning challenges the student to learn 

how to learn, while working cooperatively in groups to seek solutions to real world 

problems.  

This study is important to meeting the needs of todayôs at-risk youth. Technology 

has become something that this population of youth has begun to depend upon. It is 

natural for at risk youth to use technology such as Ipods, laptops, play stations, Xboxes, 

PCôs and Apple computers. The students of today are confident, capable and accustomed 

to learning through technology. Expanding the uses of already familiar or available 

technology has the potential to greatly enhance the studentsô sense of mastery. 



Anticipated Outcomes 

 

Throughout my research, I intend to show how integrating technology into the 

curriculum can assist at-risk youth in becoming successful in school. In looking at who is 

at-risk, I hope to provide todayôs educators with the resources available for educating 

todayôs 21
st
 century learner.  

Working with the at- risk youth population for the past seven years has given me 

the opportunity, and the skills necessary to form positive relationships with the students, 

which has allowed me to work effectively with them. I will provide strategies for dealing 

with student behavior, and demonstrate how technology can improve over all behavior.  

 

 

Research Questions  

Who are todayôs at-risk youth, and what defines at-risk? How will integrating 

technology into the curriculum assist at-risk youth in becoming successful in school? 

What tools are available to assist educators with student behavior, and technology 

integration?   

 

 

 

 

 

 

 



CHAPTER II  

Literature Review 

Who Is At Risk?  

 Many social critics argue that todayôs youth face more serious and critical risks 

than any previous generation. Most experts will agree that violence in schools, 

deteriorating family structure, substance abuse, alarming media images, and gang activity 

put teens at risk (Funderburke-Parker, 2008).      

 The overwhelming amount of literature presents a range of definitions for at-risk 

youth. Some authors identify risk factors with analytical validity for such unwanted 

behaviors as truancy, dropping out of school, or criminal activity. Others contend that all 

youth are potentially at risk of not achieving their potential. The label is often assigned to 

both gifted and remedial learners who do not fit the mainstream school population 

(Casey, 1992).  

 The most common definition of at-risk students is those students who are 

probably not going to graduate from high school (Morris, 2000). There are a great variety 

of conditions associated with being at risk. Researchers who have investigated 

characteristics correlated with a high likelihood of dropping out mention demographic, 

socioeconomic, and institutional characteristics such as:  

¶ Living in unstable school districts  

¶ Being a member of a low-income family  

¶ Having parents who are not high school graduates  

¶ Speaking English as a second language  

¶ Being single-parent children  



¶ Having negative self-perceptions; being bored or alienated; having low self-

esteem.  

 At-risk youth may be defined by a variety of factors including physical and 

developmental disabilities, impoverished conditions, or belonging to ethnic or racial 

minorities. According to Munson (1991), what makes at risk youth different is their need 

for long term counseling and supportive care. Adolescents may be considered as "socially 

disabledò because they struggle to manage the tasks of daily living and are at risk of 

having problems in school, peer groups, and family relationships (Munson, 1991).  

 A variety of external influences, ranging from family, social contacts or schools 

can be detrimental and cause a youth to function ñfrom a disadvantaged positionò 

(Lenarduzzi, 1992). These youth generally lack social skills, thus causing them to resort 

to antisocial behavior (Wallach, 1991). While not all of these youth have been previously 

involved with the juvenile justice system (Calloway, 1991), it is believed that they will 

remain at-risk until effective support is received (Pommier & Witt, 1995).  

At-Risk Factors  
 

 According to the National Youth Violence Prevention Resource Center (2007) 

risk factors are defined as scientifically established factors or determinants for which 

there is strong objective evidence of a causal relationship to a problem.  

 ñRisk factorsò in education commonly refer to situations or characteristics that 

may have a negative impact on the likelihood that a student will graduate from high 

school (Slavin, Karweit, & Madden, 1989). Although the U.S. Department of Educationôs 

National Center for Educational Statistics (NCES) has been unsuccessful in its efforts to 

get states to agree on a common definition of ñdropout,ò the best available data indicate 



that approximately 11% of U.S. students between the ages of 16 and 24 are out of school 

and have not completed high school (Kaufman, Kwon, Klein, & Chapman, 2000).  

 There are many factors which put youth at-risk for school and life failures. 

Deficiencies in a youthôs natural environment can be a significant factor in putting youth 

at risk (Munson, 1999). The school setting has also been shown to cause problems for 

many adolescents. While school programs may be effective at reducing the likelihood of 

adolescents becoming at-risk, many youth are alienated from their school environment.  

 Race/ethnicity is an indirect risk factor. Race is a complex variable for the 

purposes of categorization of risk factors. Being African American or Hispanic increases 

oneôs statistical chances of dropping out of school; however, some of the reasons for 

these statistical changes may operate at an individual level, others at a family level, others 

at a school level, and still others at a community/societal level. Poverty concentration, 

class size, and school size are all associated with lower rates of academic success. Both 

large class size and school size also appear to be detrimental to studentsô achievements 

(U.S. Department of Education, 2000). 

 Research has found that it is possible to identify potential dropouts as early as 

elementary school (McDill, Natriello & Pallas, 1986). There is  a widely held view that 

"we intervene too late in the course of a student's development, that certain parts of the 

profile of a dropout-prone student may be visible as early as the third grade," 

(Hodgkinson, 1985). 

 Much attention has been focused on such issues as adolescent suicide, illiteracy, 

teen pregnancy, substance abuse, juvenile crime, school dropouts, and youth 

unemployment. These are in fact symptoms. The real root causes that put youth "at riskò 



are, poverty, lack of family support, negative peer pressure, and sometimes 

neighborhood, skin color, ethnic background, or language barriers. A lack of parental 

interaction and involvement increases the risk for violence, particularly among males.
 

Failure to set clear expectations, inadequate youth supervision and monitoring, and 

severe or inconsistent family discipline practices can also contribute to delinquency and 

violent behavior (Sauer, 1990). 

 It has been established that up to 50 percent of teens, particularly in the late teen 

years, abuse substances such as alcohol, marijuana, and cocaine; many of them become 

dependent upon such substances. Some of these youth may be self-medicating in an effort 

to escape their unhappiness. Still others, due to their lack of inhibition, may be unable to 

stop doing something that provides pleasure (Goldstein, 1998). 

Juvenile Justice System and Education 

 The juvenile justice system faces enormous challenges in dealing with at risk 

youth. Positive steps must be taken within communities, such as giving families in crisis 

access to agencies capable of providing a variety of services. Parents must recognize that 

they need to become part of the solution, giving youth the skills necessary to become 

productive members of society. With the help of caring and informed adults, it is possible 

to turn these youth around before they become another statistic (Bartollas & Miller, 

2001). 

 One important strategy for improving the effectiveness of our correctional 

institutions for youth is education. Without education, practical skills, programs that help 

change anti-social behavior, and transition steps back into the community, what chance 

do these youth have of becoming productive members of society? The penal system 



generally provides punishment but little support to help these youth develop more 

effective and efficient life skills and success in daily life, and, thus the ability to stay out 

of trouble (Schwablearning, 2008). 

 The link between illiteracy and juvenile delinquency is well documented. Michael 

S. Brunner, Visiting Research Fellow at the U.S. Department of Justice, reported that the 

link between academic failure and delinquency is strong. Schools are contributing to the 

delinquency problem by continuing to provide traditional programming that leaves many 

students unable to read accurately, fluently, and effortlessly with comprehension. What 

brings about the delinquency is not the academic failure per se, but sustained frustration 

which results from continued failure to achieve selected academic goals (Citizens 

Commission on Human Rights, 2000). 

 Some argue that the large number of youth struggling with the Massachusetts 

Comprehensive Assessment System, the Massachusetts high stakes graduation 

requirement implemented in 2003, is increasing the drop-out rate, which means that the 

current number and proportion of young adults lacking a credential may be higher than it 

was in 2000 at the time of the Census (Papay, Murnane, Willett, 2008).  

Behavior Management 

  

 According to (CLASS, 2008) Behavior Management encompasses the teacher's 

ability to provide clear behavioral expectations and use effective methods to prevent and 

redirect misbehavior.  

Students are most likely to behave appropriately in the classroom when:  

 

¶ Rules and expectations are clearly and consistently communicated.  

 

¶ Behavior management is proactive, rather than reactive.  

 



¶ Students receive consistent praise for meeting expectations (CLASS, 2008).  

 

 

 With clear expectations, students typically understand how to act in the classroom 

so that little time is spent on managing their behaviors. This can minimize distractions 

and disruptions, allowing classroom time to be spent on instructional activities, and 

increases the amount of time students are engaged in learning. Dealing with student 

behavior can be draining for teachers and students. By reducing the frequency and 

intensity of behavioral problems, more learning can take place (CLASS, 2008).  

 Haim Ginott was the first to support the role of communication skills in building 

sound classroom discipline. He presented a strong case for what he called ñcongruent 

communication,ò a style of speaking that does not attack others, but instead remains 

harmonious with feelings being experienced (Charles, 1998, p 57). 

 Ginott described discipline as a ñseries of little victoriesò that over time helps 

students acquire self-direction, responsibility, and concern for others. He believed that 

true discipline could not be accomplished over night, but is a process that grows 

gradually as teachers treat students humanely and considerately (Charles, 1998, p 67). 

 The essence of discipline, Ginott said, lies in finding effective alternatives to 

punishment. Ginott believed that the most important factor in improving classroom 

behavior is the teacherôs self-discipline. Self-disciplined teachers rarely lose their tempers 

and they never behave rudely. They model the behaviors they want to see in their 

students (Charles, 1998, p 67). 

 The use of certain classroom management techniques can help teachers achieve 

well-disciplined classrooms.  Some training programs have been proven to be very 



successful in bringing about reductions of discipline problems in the classroom. Training 

programs for educators should include learning activities and practice in the areas of:  

¶ Organizing the room and materials  

¶ Developing a workable set of rules and procedures  

¶ Assuring student accountability  

¶ Formulating and explaining consequences  

¶ Maintaining the management system  

¶ Increasing instructional clarity  

¶ Organizing instruction  

¶ Adjusting instruction for special groups (Cotton, 1990).  

21
st
 Century Learning  

 At-risk youth are often sent to special programs with reduced expectations for 

academic performance. The effective schools research strongly supports the idea that 

schools establish and maintain high expectations and standards for all students and focus 

on helping students meet those expectations. At-risk youth do exhibit a strong need for 

success, however with clear goals and objectives, they can begin to move toward and 

achieve measurable success in school (Druian & Butler, 1987). 

 The No Child Left Behind Act of 2001 is placing a new emphasis on scientifically 

based research and is requiring states and school districts to choose ñevidence-basedò 

programs for their schools and classrooms. Certain programs or approaches are effective 

in improving student outcomes when implemented (Waxman, Lin, & Michko, 2003).  

 Some studies have found that using technology can change teachersô approaches from 

a teacher-centered to a more student-centered classroom where students work willingly, have 



opportunities to make choices, and play an active role in their learning. Research has 

compared the classroom interactions between high school students and teachers involved in 

(a) computer-based instruction and (b) traditional instruction. It was found that student-

teacher interactions were more student-centered and individualized during computer-based 

teaching and learning than in traditional teaching and learning (Sandholtz, Ringstaff, & 

Dwyer, as cited in Waxman, Lin, & Michko, 2003). 

 Another study that examined changes in classroom instruction as a result of 

technology found that high access to computers enabled teachers to individualize instruction 

more. Technology permits students to be involved in their own learning. With no history 

of failure, it allows at-risk youth to be successful at something, to build up their 

knowledge, and become part of the teaching process (Sandholtz, Ringstaff, & Dwyer, as 

cited in Waxman, Lin, & Michko, 2003). 

 A variety of technological tools can be useful in working with at-risk youth. 

Youth usually have positive experiences with technology, and individualized teaching 

and learning can, and does take place without the normal resistance to obvious 

educational approaches (Casey, 2000). 

 According to the Association for Educational Communications and Technology, 

(2004) instructional technology is defined as:  

ñ...the use of a variety of teaching tools to improve student learning. We 

usually think of computers and computer software when we think of 

instructional technology, but instructional technologies are not limited to 

computers in the classroom. Instructional technology describes all tools 

that are used for teaching and learning such as: cameras, CD players, 

PDA's, GPS devices, computer-based probes, calculators and electronic 



tools we have yet to discover. Students and teachers use computer 

software and Internet resources to locate, process, and present information, 

learn and assess their skillsò. (np). 

 Students will spend their adult lives in a multitasking, multifaceted, technology-

driven, diverse, vibrant world. The world in which students live today has changed 

dramatically, and schools must be prepared to change as well, to meet the demand of 

educating the 21
st
 century learner. Technology helps prepare students for the workforce 

when they learn to use and apply applications that are used in todayôs workforce (Trotter, 

1997). 

 

The Evolution of Technology in Education 

 The United States Congress has a long history of supporting technology for 

people with disabilities, dating back to 1879, when a $10,000 grant was made to support 

the production of Braille materials at the American Printing House for the Blind. Funding 

for captioning films for people who are deaf was provided in 1958. The primary rationale 

for laws such as these was to provide technology resources that could be used to improve 

instruction for people with disabilities. As public school programs for students with 

disabilities increased, a need was identified to improve the access to instructional 

materials, media, and technology by special education teachers (Blackhurst, & Edyburn, 

2000).  

American with Disabilities Act of 1988 

 The Americans with Disabilities Act gives civil rights protections to individuals 

with disabilities similar to those provided to individuals on the basis of race, color, sex, 



national origin, age, and religion. It guarantees equal opportunity for individuals with 

disabilities in public accommodations, employment, transportation, State and local 

government services, and telecommunications (ADA, 2006).  

 Federal policy related to assistive technology was solidified with the passage of 

Public Law (PL) 100-407, the Technology-Related Assistance for Individuals with 

Disabilities Act of 1988, which was the first major legislation exclusively directed to 

assistive technology. The legislation provided funding to support statewide planning and 

support for the delivery of AT services. The "Tech Act," as it has come to be known, 

provided definitions of AT devices and services. Those definitions were slightly modified 

in the re-authorization of PL 105-17, The Individuals with Disabilities Education Act, to 

make the wording of the definitions applicable to children with disabilities in schools. As 

defined in Section 300.5 of IDEA (Blackhurst & Edyburn, 2000). 

 According to the Individuals with Disabilities Education Act (IDEA, 2004), 

assistive technology (AT) is defined as ñ...any item, piece of equipment or product 

system, whether acquired commercially off the shelf, modified, or customized, that is 

used to increase, maintain, or improve functional capabilities of individuals with 

disabilities.ò  

 AT address many types of learning difficulties. A student who has difficulty 

writing can compose a school report by dictating it and having it converted to text by 

special computer software. A child who struggles with math can use a hand-held 

calculator to keep score while playing a game with a friend. And a teenager with dyslexia 

may benefit from AT that will read aloud his employerôs online training manual 

(Stanberry, & Raskind, nd.).  



 Many common software applications have built-in capabilities that can be useful to 

students with disabilities. For example, most applications allow the user to modify the size 

and color of text, which can be useful for a student with low vision. Also many popular 

word-processing applications offer a text-to-speech features, which is useful for students 

with a variety of disabilities. In addition, most computer operating systems have 

accessibility features, for example allowing the user to magnify the screen, change the 

size of icons, and adjust the way the mouse and keyboard react (MDOE, 2008). 

Software and Assistive Technology 

 

 Current research supports a direction away from the traditional, teacher-centered 

(didactic) direct instruction, where students are passive receptors of knowledge, towards 

the more student-centered, understanding-based (constructivist) teaching that focuses on 

ideas constructed by the students own knowledge, observations and experiences 

(Smerdon, Burkham, & Lee, 1999).  

 According to Wenglinsky (2005), teachers tend to be one of two types:  

1. Didactic: in which students are taught basic skills primarily through having 

the teacher provide the knowledge and students receive it 

2. Constructivist: in which students are taught complex problem-solving skills in 

an interactive process that moves from abstractions to concrete examples, 

where students control most of the learning process. 

 As a hands-on subject, technology education demands that students interact with 

their learning environment. When deciding what technology to use one should take into 

consideration: 

 

¶ The lesson to be taught 

 



¶ The appropriate technology to be used 

 

¶ How that technology is to be used 

 

¶ Limitations on the technology 

 

¶ The ability of the technology to achieve the expected outcome (Jones, 1999). 

 Currently, there are more than 30,000 pieces of educational software available, 

with hundreds of new titles being added yearly. With more than a thousand titles 

available for a single subject area, it is nearly impossible for educators to sort through to 

see if a particular piece of software has been evaluated (Higgins & Boone, 2008). 

Selecting the right educational software package has become increasingly complex.  

 There are many issues to consider in selecting educational software:  

¶ Evidence of its effectiveness;  

¶ Alignment with your school, state, or district's standards;  

¶ Suitability for your students' needs and learning styles;  

¶  Total cost of purchasing, maintaining, and upgrading needed hardware and 

software (Learning Point Associates, 2002). 

 Technology, according to Jendron, (2007) has great potential in providing access 

for all learners. Through the use of assistive technologies, students with disabilities can 

have access the general curriculum. When assistive technology is appropriately integrated 

into the regular classroom, students are provided with multiple means to complete their 

work. Technology helps students with disabilities on many different levels. It can help 

them accomplish tasks such as:  

¶ Master grade-level content. Technology presents the material in different forms 

(visually, auditorily, etc.)  



¶ Improve writing and organizational skills. Technology can enable students with 

learning disabilities to develop a concept map for a research paper and write using 

grade-level vocabulary words they wouldn't use without a computer due to poor 

spelling skills.  

¶ "Read" grade-level text. The computer either reads the text audibly, digitally or 

presents it at a lower grade level for students with reading disabilities or visual 

impairments.  

¶ Take notes. Many students with disabilities have difficulty taking notes because 

of poor spelling, writing, and/or eye-hand coordination skills (Jendron, 2007). 

 Assistive technology can help youth with special needs by providing 

accommodations and adaptations to support educational programs that are already in 

place. In connection with disability issues, the term ñaccommodationsò refers to a change 

in routine, method or approach that is used so that a person with a disability can 

participate in spite of challenges the disability might pose (Jendron, 2007). 

 

 

Potential Classroom Uses  

 Janet Jendron (2007), of the University of South Carolina Assistive Technology 

Project, writes: 

 ñFor some students with learning disabilities, learning to spell words 

correctly may be a skill they cannot acquire or cannot acquire with enough 

fluency to be able to express themselves adequately in writing. To 

compensate for this inability, these students may be encouraged to use 



alternative methods for spelling like a spell check program on the 

computer or a hand-held spelling device. Youth can advance their 

education and acquire new skills using a variety of assistive technology 

tools in the classroomò (np). 

1. Reading Deficit 

 

 Encyclopedia of Mental Disorders (2008) defines Reading disorder as ña learning 

disorder that involves significant impairment of reading accuracy, speed, or 

comprehension to the extent that the impairment interferes with academic achievement or 

activities of daily life. People with reading disorder perform reading tasks well below the 

level one would expect on the basis of their general intelligence, educational 

opportunities, and physical healthò (np). 

¶ Reading software improves reading comprehension, vocabulary, grammar, 

writing skills, and teaches reading strategies that allows youth to become fluent 

and accurate readers (Jendron, 2007).  

¶ Text Readers are software programs that read aloud all the text in any given 

document or application and often include other assistive features such as word 

prediction and spell check (Jendron, 2007). Having text read aloud benefits 

anyone having difficulty reading information on the screen or for whom 

simultaneously hearing and reading text aids comprehension. Talking software 

can help a child see and hear while learning (ATTO, 2005). 

¶ Talking word processors are writing software programs that provide speech 

feedback as the student writes, echoing each letter as it is typed and or each word 

as the spacebar is pressed (ATTO, 2005).   



¶ A portable word processor is a lightweight device that is easy to transport (e.g., 

from classroom to home). It can be helpful to students who may have trouble 

writing by hand and prefer to use a keyboard. Word processing allows the user to 

edit and correct his written work more efficiently than doing so by hand 

(Stanberry & Raskind, nd.).  

¶ Talking spell checkers and electronic dictionaries can help a poor speller select or 

identify appropriate words and correct spelling errors during the process of 

writing and proofreading.  Talking devices ñread aloudò and display the selected 

words onscreen, so the user can see and hear the word options (Stanberry, K. 

Raskind, M. Ph.D., nd.). 

¶ Word prediction software assists people who have difficulty spelling and writing. 

As a person types, word prediction will display a list of the most probable words 

allowing the typist to select the word from the list. The built-in talking dictionary 

lets the typist hear the definition to make sure that the word they select is the right 

word (Premier Literacy, 2008). 

2. Visual Deficit 

 

 Visual aids for assisting with vision problems can increase contrast, enlarge 

stimuli and make use of tactile and auditory models. Devices that assist with vision 

include screen readers, screen enlargers, magnifiers, large-type books, taped books, 

braillers, light boxes, high contrast materials, thermoform graphics, synthesizers, and 

scanners (Higgins & Boone, 2008).  

¶ Visual programs rely on visual learning, which is a proven method of organizing 

ideas graphically - with concept maps, mind maps and webs. Scientifically based 



research demonstrates that visual learning techniques improve memory, 

organization, critical thinking and planning. Visual learning helps students 

improve academic performance and achieve success across the curriculum 

(Novak & Cañas 2006). 

¶ Graphic organizers and outlining programs help users who have trouble 

organizing and outlining information as they begin a writing project. This type of 

program lets a user ñdumpò information in an unstructured manner and later helps 

organize the information into appropriate categories and order (Higgins & Boone, 

2008).  

¶ Electronic Braille devices allows the user's input to be converted into electronic 

signals which are stored as a digital file, and any tactile output is produced 

indirectly by displaying the file on a refreshable Braille display or printing it with 

an embosser (Dotlessbraille, 2007). 

3. Math Deficit  

 When a student who is unable to remember math facts is allowed to do math 

problems with a calculator, the use of the calculator is an accommodation that enables the 

student to work around his or her disability. With this accommodation, the student can 

still solve math problems but uses a different method (Jendron, 2007). 

¶ A talking calculator has a built-in speech synthesizer that reads aloud each 

number, symbol, or operation key a user presses; it also vocalizes the answer to 

the problem. This auditory feedback may help the student check the accuracy of 

the keys he presses and verify the answer before he transfers it to paper (Stanberry 

& Raskind, nd.). 



¶ Electronic math worksheets are software programs that can help a user organize, 

align, and work through math problems on a computer screen. Numbers that 

appear onscreen can also be read aloud via a speech synthesizer. This may be 

helpful to people who have trouble aligning math problems with pencil and paper 

(Stanberry & Raskind, nd). 

¶ On line math videos appeal to the visual learners. According to Christopher 

Matawa, most students benefit from visual representations of concepts (1998). 

Using manipulatives in the classroom assists with goals and is in keeping with the 

progressive theories of discovery and inquiry-based learning. Individual students 

learn in different ways. When manipulatives are used, the senses are brought into 

learning: students can touch and move objects to make visual representations of 

mathematical concepts (T2T, 2008). 

4. Attention Deficit  

 

 Children with a diagnosis of Attention Deficit Hyperactivity Disorder (ADHD) 

are typically kinesthetic learners and have difficulty with sitting at a desk doing pencil-

and-paper work.  When children think of themselves as ñstupidò or ñslow ñand are seen 

as such, they often will be disruptive in school. Consideration of various means of 

presentation of materials when working with students with ADHD is recommended 

(FAS, 2008). 

 Computer instruction can support other learning activities, and can also provide 

motivation and focus for students with learning disabilities. Assistive technology can help 

students communicate with a least amount of stress and confusion. Special software can 



also help a child with ADD reduce the effect of external stimuli, improving the ability to 

focus on class work (Jendron, 2007). 

¶ Audio books allow users to listen to text and are available in a variety of formats, 

such as audiocassettes, CDs, and MP3 downloads. Special playback units allow 

users to and search and bookmark pages and chapters (Stanberry & Raskind, nd.).  

¶ Speech recognition programs work in conjunction with a word processor. The 

user ñdictatesò into a microphone, and his spoken words appear on the computer 

screen as text. This can help a user whose oral language ability is better than his 

writing skills (Stanberry & Raskind, nd.). 

¶ The Internet is making it possible for more individuals than ever to access 

knowledge and to learn in new and different ways. The internet allows educators 

to center learning around the student instead of the classroom, to focus on the 

strengths and needs of individual learners, and to make lifelong learning a 

practical reality (USDOE, 2000). 

5. Additional Graphics & Multimedia  to address learning challenges.  

 Multimedia software can easily present information in either text mode or 

graphics mode, but, when possible, both should be used (Overbaugh, as cited in Stemler, 

1997). Students who do not understand information delivered by text often will 

understand it if it is presented by various varieties of multimedia. In particular, 

challenging topics sometimes become easier to understand when augmented by graphic 

displays (Gropper, as cited in Stemler, 1997). 

 Multimedia programs can be used to present information in many ways by 

combining multimedia techniques with instruction. High-quality presentations can be 



created when they are based on objectives that focus on the learning of topics at different 

levels of comprehension (Gropper, 1983). It is better to present an explanation using two 

modes of representation rather than one, in words and pictures than solely in words 

(Mayer & Moreno, nd).  

 

Podcasting  

 Podcasting provides another way of sharing and transmitting audio for teaching 

and learning in schools and at home. There is a variety of information available on how 

to create, produce and publish podcasts on the Internet. Anyone can create a podcast; all 

one needs is a computer, a microphone, and the Internet access.  

¶ Audio podcasts can be synchronized with many popular MP3 players allowing 

students to publish on the Internet using basic software. 

¶ Enhanced podcasts include chapter marks, images that change at predetermined 

times when the podcast is played and hyper links to websites. One can move to 

different chapters in the podcast, a feature also used in audio books. 

¶ Video podcasts (sometimes referred to as vodcasts) are the very latest in 

podcasting and provides a visual and audio experience for the learner (Educate, 

2008).  

Blogging 

¶ Educational blogging allows students to express themselves and to receive 

feedback, within the confines of the technology and the educational environment 

it is implemented in, as the teacher will be actively watching the content and the 



dialogue. It can give students a vision of their ability to add to the accumulated 

knowledge and understanding in journaling or writing (Hargadon, 2008).  

 The use of multimedia as a learning tool can increase the teacherôs effectiveness 

at demonstrating subject matter. Students can use multimedia presentations to enhance 

any subject matter demonstration, discussion, or report (Obiakor, 2007). However, for 

students who are at-risk, teacher directed multimedia lessons on specific skills will not 

necessarily assist the transfer of learning to real-life situations without meaningful 

dialogue and activities related to the content (Obiakor, 2007). 

 Multimedia can help create situations that stimulate interest, generate questions, 

find problems, or motivate investigations. The integration of multicultural education into 

educational technology can be vital to closing the digital divide for some students 

(Obiakor, 2007). Multimedia products provide supportive environments in which 

multicultural students can practice their writing, reading and communication skills 

(Obiakor, 2007). 

 Technology has the potential to transform the lives of students, opening up new 

worlds and enabling them to learn when, where and how they choose to, but educational 

professionals must be aware of the needs of these youth. It is necessary to connect 

students' lives to the curriculum of the classroom (McQuillen, 2003).   

 As we begin to move beyond the Internet as merely a library where you go to look 

up information, to a place where all users can contribute knowledge and insights, we need 

to recognize that the potentials for teaching and learning in these environments are 

exciting and enormous (Hargadon, 2008).  

 



6. Software Evaluation Tools 

As an educator, one is faced with software choices. The evaluation of educational 

software must take into account the usability, as well as learning effectiveness. Choosing 

the best software is an important task. The best way to evaluate the appropriateness of 

software programs for at risk youth is the response of students and teachers (Dudley & 

Owston, 1987).  Software should not be too easy or too hard for the student. The software 

program should be challenging to maintain the attention of the student. Software should 

be entertaining and educational for the maximum results with at risk youth (Gray, 1991).   

Kathy Schrock has created a simple software evaluation tool for teachers who are 

considering purchasing software (Appendix A). This resource facilitates decision-making 

about instructional software. There are few software programs to which one would apply 

all of the criteria, and one may need to omit the criteria that are not appropriate to the 

type of software being evaluated. There is no substitute for trying the actual software, and 

any review should only be used as a guide (Schrock, 2007). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

CHAPTER III  

 

Methods 

 

  I have been teaching at-risk youth, grades seven through twelve, with 

special needs, and behavioral problems, for the past seven years. I have found that these 

youth love technology. Most days itôs difficult for me to get them to leave my classroom.  

 There is plenty of evidence that people do not all learn in the same way. Yet 

teachers often teach all students in the same way, using the same methods that have been 

successful in their own learning. Technology is a way of life for these youth to tap into 

their curiosity and creativity, and allows for risk taking. 

 My students are all on behavioral contracts; we use a point system where 

technology can be used as an incentive for positive behavior. Many educators have found 

creative ways of integrating technology into their curriculums. This guide will provide 

many resources that have been used effectively with my students.   

 Educational systems make available a variety of models such as private, religious, 

and home schools. Alternative programs tend to feature strict discipline and activities that 

build self-esteem and social skills. High academic expectations are characteristics of 

successful alternative programs. Maintaining behavioral and academic expectations are 

crucial to the success of these programs (McDonald, 2002). 

 Research shows that there are a great number of factors that lead to students 

acquiring the label ñat-risk.ò We need to take into account these factors, and maintain 

healthy boundaries when working with this population of youth. All children can learn; 

schools and teachers do make a difference.  Learning is all about the connections made.  



 Negative consequences are not the most effective way of eliminating problem 

behavior. It is important that positive consequences are used with students because they 

usually have a history of punishment to which they have grown accustomed. 

 By using this resource guide, teachers will be armed with the tools needed to 

manage the acting-out behaviors of at-risk youth using both technical interventions and 

those that do not involve technology. Teachers will also acquire technological tools to 

enhance teaching and learning. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

CHAPTER IV  

 

 

A Guide for Teachers: 

 

Using Technology 

to Positively Influence Studentsô 

 Engagement, Behavior, and Learning.  
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CHAPTER I  

 

Specific Strategies to Deal with Student Behavior 

Behavior Contracts 

 Before you can begin to teach, student beha32vior must be addressed. Any 

student who needs extra structure, incentive to change bad behavior, support, and 

discipline will benefit from a behavioral contract. Behavior management encompasses 

many important concepts, such as developing a rapport with the students, establishing 

procedures and setting up positive behavior management systems.  

 Student behavior problems are challenging at all levels in todayôs schools. 

According to the Center for Effective Collaboration and Practice (2001), ñDifficult 

student misbehaviors, reported by teachers included violation of classroom rules, being 

truant from school, blaming others for problems, irresponsible behavior, and destruction 

of property.ò 

  Implementing and following classroom rules that specifically address behavior 

encourages positive classroom participation and improves over all learning. Students 

should be redirected for inappropriate behavior before the behavior becomes out of hand.  

Well-defined classroom rules are useful in controlling problems and helping to prevent 

irresponsible behavior.   

 A behavior contract is an agreement between the teacher and the student, that 

sets limits for student behavior, rewards good choices, and outlines consequences for bad 

choices (Lewis, 2008). When creating a behavior contract, you should involve the 

student. Clearly defined rewards that allow the student the option to change the specific 



behavior you want to change should be emphasized. In allowing the student to provide 

the rewards and consequences, he or she may be more invested in the behavior system.  

 Specific problems should be addressed as they occur, while good behavior should 

be praised as often as possible. The more students receive attention for the positive things 

they do, the less apt they are to look for attention in a negative way. One should always 

give the student a way out of the behavior by providing options instead of telling the 

student what to do. You must be very consistent with the studentsô behavior in the 

classroom. 

 Educators must always set boundaries, and stick to them. Maintaining healthy 

boundaries when working with youth who manipulate to get their needs met is crucial, 

because it sets limits. When talking about boundaries, we refer to how much we think we 

can share, receive, give, and how physically close we can become to our students, 

colleagues, friends, strangers and family. Educators should always maintain and reinforce 

healthy boundaries with students. Boundaries are essential in setting limits with at-risk 

youth.   

 Some students may not have the ability to set appropriate boundaries. Behavior 

contracts can help in changing the behavior of these students, so that they no longer 

disrupt learning in your classroom. Students should be involved in creating their behavior 

contracts, so that all expectations can be met (Appendix B). Research shows that the most 

important factor in student behavior and performance is the teacher/student relationship. 

Good communication and respect between teacher and students works (Watson, 2003). 

Strive to create a positive learning experience. 



 Haim Ginott repeatedly points out that students can be extremely sensitive.  Being 

bossed around and labeled gives students validation for disrupting teachers and behaving 

defiantly. Teachers should therefore treat students as they themselves want to be treated, 

which can lead to better student performance and behavior (Charles, 1998, p. 67). 

 

 

Students want teachers who: 

¶ Respect them 

¶ Care about them  

¶ Listen to them 

¶ Don't yell or shout 

¶ Have a sense of humor 

¶ Are in a good mood 

¶ Let students give their opinions (Watson, 2003).  

Clear Expectations & Assessment 

 Student expectations should be clear at start of each lesson, and reinforced 

throughout the lesson. By using a rubric,  students have a working guide for their 

assignments. A rubric should focus on measuring a stated objective, performance, 

behavior, and quality of work (Appendix C). 

 When not presented with clear expectations, assignments can become frustrating 

for these students. You have to make expectations clear or you will expect one thing and 

get something else. Stating and posting expectations in the classroom can result in 

enhanced performance, and higher expectations can equal a better quality of work. When 



you lower your expectations, students will slack off and achieve less than their best.   

  

 Students with a learning disability should be treated like other students. Some 

modifications to the curriculum may be needed in the way information is presented and in 

the methods of testing and evaluation. Assessments can reveal what individual students 

know and are able to do (South Dakota State University, 2009). Self assessments have a 

range of potential advantages for at-risk youth. They involve learners in their learning 

and given feedback about the quality of their work and how to make it better. 

Rewards / Incentives 

 There are many teachers across the country who are successfully motivating 

todayôs at- risk youth. Many are doing it without resources or special training. They are 

doing it because of their ability to make their classrooms a place their students want to 

be. These teachers have created a classroom where their students want to return to each 

day.  

 Rewards that reinforce learning can help students remember classroom 

expectations. Creating t-shirts, burning Cdôs and printing photos are only a few rewards 

that work with at-risk youth. Rewards can help students become proficient in mastering 

the expectations of acceptable classroom behavior. 

 Fredric Jones, the developer of Positive Classroom Management and the author of 

Positive Classroom Discipline, speaks of genuine incentives. When we think of 

Grandmaôs rule, ñfirst you eat your vegetables, then you can have your dessert,ò we donôt 

think of education. However, applied to the classroom, the rule requires students to first 



do what they have to, to be able to do what they want. The incentive is the end product; 

students must complete their assignments to receive the incentive (Charles, 1998, p 106).  

 One of the greatest motivators to improve student behavior is to provide an 

incentive or reward for appropriate behaviors that occur over a defined period of time 

(Watson, nd).  Allow students to choose their incentivesïprovide a list of some things that 

have worked. Some incentives that have worked for this researcher are: 

¶ 15 minutes of free activity 

¶ Earn points for a class video 

¶ Wear your favorite hat on Fridayôs 

¶ Have lunch with your favorite person or the teacher 

¶ Free time in another classroom 

¶ Receive a positive note or phone call to parent or guardian 

¶ Purchase items using your School Dollars, such as playing cards, t-shirts, CDôs to 

burn or snacks 

¶ Purchase something from the school store 

¶ Earn tickets toward free time 

¶ Earn $5.00 gift card of choice 

¶ Downloading music 

¶ Free pencil s or pens 

¶ Free photo paper and frames 

¶ Earn pizza for your whole class 

¶ Free homework passes 

¶ Enjoy social networking sites with the teacherôs assistance  



¶ Listen to the radio or CD for a specified period of time 

¶ Enjoy a playing a game with a friend or teacher 

¶ Such as,  pool, chess or ping pong (Watson, n.d).  

Classroom Environment: 

 The classroom environment is very important; one should make it attractive, 

comfortable, and functional. Teachers should greet each student personally as they enter 

class each day; this allows students to feel welcomed. Comment positively and 

appropriately on their demeanor when possible, their smile, and their kindness to 

someone else. This researcher has seen that positive reinforcement is an effective means 

of influencing behavior. 

 These students love praise; often they think that theyôre the most important person 

in the classroom. Educators should find positive things to say about each student, and say 

it as often as possible, but always remembering that not all students can handle public 

praise.  Praise must be for genuine achievement. These youth know when one is lying 

and they appreciate the truth. Too much praise can lead to a student becoming dependent 

on it. The student then begins to need constant praise and develops no personal initiative.  

Classroom Engagement:  

 Often at-risk youth have been traumatized at an early age when they have not yet 

learned to speak and may not have had words for their experiences. Many of these 

students express their experiences behaviorally, instead of verbally. Instead of reacting to 

these students, one must reach out to them and try to gain their trust.  

 Building trust with difficult students is not an easy process. Taking a personal 

interest in each student is where educators need to begin. Most students come to school 



trusting their teachers. However, theses students do not trust, or like school and do not 

see any point in behaving appropriately. They find satisfaction in disrupting class by 

being verbally abusive. One needs to think before responding to these students (Charles, 

1998).  Meaningful communication with at-risk youth shows caring for the students as 

individuals, and allows them to be themselves. 

 Students behave when they are involved and engaged in their learning. 

Constructivist uses of technology can help students learn better than they would 

otherwise, whereas didactic uses of technology make the technology useless or even 

damaging. Student involvement is an essential aspect of meaningful learning. The term 

constructivism in all probability is derived from Jean Piaget. 

In Piaget's view, intelligence consists of two interrelated processes, organization 

and adaption. People organize their thoughts so that they make sense, separating 

the more important thoughts from the less important ones as well as connecting 

one idea to another. At the same time, people adapt their thinking to include new 

ideas, as new experiences provide additional information. This adaptation occurs 

in two ways, through assimilation and accommodation. In the former process, 

new information is simply added to the cognitive organization already there. In 

the latter, the intellectual organization has to change somewhat to adjust to the 

new idea. (Berger, 1978, p. 55) 

 Constructivism is a theory based on observation and scientific study, about how 

people learn.  People construct their own understanding and knowledge of the world, 

through their own experiences and reflecting on those experiences. Constructivist 

teachers encourage students to constantly assess how the activity is helping them gain 



understanding. By questioning themselves and their strategies, students in the 

constructivist classroom can become expert learners. This gives them ever-broadening 

tools to keep learning (Matsuoka, 2004).  

 With a well-planned classroom environment, the students learn how to learn. 

Always guided by the teacher, students construct their knowledge actively rather than just 

automatically gaining knowledge from the teacher or the textbook. 

 The strategies mentioned can assist educators in maintaining classroom behavior. 

When student behavior is addressed before it gets out of hand, overall behavior and 

classroom participation improves. Donôt fear trying something new with these students, 

they can adjust to most anything.  

 

 

 

 

CHAPTER II  

 

Office 2007 Tutorials:   

 

 There are many resources available for educators involving technology in the 

classroom, such as web sites with teacher created assignments, free tutorials, Web quests, 

podcasts, videos and blogs.  

 In order to prepare educators to use todayôs software; I have created two Office 

2007 tutorials for using Microsoft Word, and Power Point with the help of 

GCFlearnfree.org. GCF offers computer and technology training tutorials absolutely free. 

By creating a free account, educators and students can learn online at their own pace at 

http://www.gcflearnfree.org. 

http://www.gcflearnfree.org/


  These tutorials will not make educators and students entirely technologically 

literate, but with hard work and time, these tutorials can assist in the ongoing process of 

educating and preparing them for the 21st century world. 

 
©1998-2009 GCFLearnFree.org®. All rights reserved. 

 

 

 



Introduction to Microsoft Word  

Word 2007 is the word processing software in the Microsoft 2007 Office Suite. It allows 

you to easily create a variety of professional-looking documents using features such as 

themes, styles, SmartArt, and more.  

Setting up Your Word Environment 

  
Before you begin creating documents in Word, you may want to set up your Word 

environment and become familiar with a few key tasks such as how to minimize and 

maximize the Ribbon, configure the Quick Access toolbar, display the ruler, and use the 

Word Count and Zoom tools. 

Tasks to Set Up and Use Word 

To Minimize and Maximize the Ribbon: 

¶ Right-click anywhere in the main menu.  

¶ Select Minimize the Ribbon in the menu that appears. This will toggle the 

Ribbon on and off. 

 

The check mark beside Minimize the Ribbon indicates the feature is active. 



The new, tabbed Ribbon system replaces traditional menus in Word 2007. It is designed 

to be responsive to your current task and easy to use; however, you can choose to 

minimize the Ribbon if you would prefer to use different menus or keyboard shortcuts. 

To Add Commands to the Quick Access Toolbar: 

¶ Click the arrow  to the right of the Quick Access toolbar.  

¶ Select the command you wish to add from the drop-down list. It will appear in 

the Quick Access toolbar. 

 
The Save, Undo, and Redo commands appear by default in the Quick Access toolbar. 

You may wish to add other commands to make using specific Word features more 

convenient for you.  

To Display or Hide the Ruler: 

¶ Click the View Ruler icon over the scrollbar. 



 
 

The View Ruler icon works as a toggle button to turn the ruler on and off. 

Text Basics 

 

It is important to know how to perform basic tasks with text when working in a word 

processing application. In this lesson you will learn the basics of working with text 

including how to insert, delete, select, copy, paste, drag and drop text.  

Working with Text  

To Insert Text: 

¶ Move your mouse to the location you wish text to appear in the document.  

¶ Left-click the mouse. The insertion point appears.  

¶ Type the text you wish to appear. 

To Delete Text: 

¶ Place your cursor next to the text you wish to delete.  



¶ Press the Backspace key on your keyboard to delete text to the left of the cursor.  

¶ Press the Delete key on your keyboard to delete text to the right of the cursor. 

To Select Text: 

¶ Place the insertion point next to the text you wish to select.  

¶ Left-click your mouse and while holding it down, drag your mouse over the text 

to select it.  

¶ Release the mouse button. You have selected the text. A highlighted box will 

appear over the selected text. 

When you select text or images in Word, a hover toolbar with formatting options 

appears. This makes formatting commands easily accessible, which may save you time. 

To Copy and Paste Text: 

¶ Select the text you wish to copy.  

¶ Click the Copy command on the Home tab.  

¶ Place your insertion point where you wish the text to appear.  

¶ Click the Paste command on the Home tab. The text will appear. 

 
 

To Drag and Drop Text: 

¶ Select the text you wish to copy.  



¶ Left-click your mouse and drag the text to the location you wish it to appear. The 

cursor will have a text box under it to indicate that you are moving text. 

 

¶ Release the mouse button and the text will appear.  

If text does not appear in the exact location you wish, you can click the Enter key on 

your keyboard to move the text to a new line. 

 

 

Saving Documents 

 

It is important to know how to save the documents you are working with. There are many 

ways you share and receive documents, which will affect how you need to save the file.  

Are you downloading the document? Saving it for the first time? Saving it as another 

name? Sharing it with someone that does not have Word 2007? All of these things will 



affect how you save your Word documents. In this lesson you will learn how to use the 

save and save as commands, how to save as a Word 97-2003 compatible document, and 

how to save as a PDF. 

To Use the Save As Command: 
¶ Click the Microsoft Office Button .  

¶ Select Save As Word Document. The Save As dialog box appears. 

 

¶ Select the location you wish to save the document using the drop-down menu.  

¶ Enter a name for the document. 

 



¶ Click the Save button. 

To Use the Save Command: 

¶ Click the Microsoft Office Button .  

¶ Select Save from the menu. 

Using the Save command saves the document in its current location using the same file 

name. If you are saving for the first time and select Save, the Save As dialog box will 

appear. 

To Use the Save As Word 97 - 2003 Document: 

¶ Click the Microsoft Office Button. 

¶ Select Save As Word 97-2003 Document. 

 

¶ Select the location you wish to save the document using the drop-down menu. 

¶ Enter a name for the document. 

¶ Click the Save button. 



To Download the PDF Extension: 
¶ Click the Microsoft Office Button. 

¶ Select Save As Find add-ins for other file formats. This will open your web 

browser to the Microsoft site. 

¶ Follow the instructions on the Microsoft site for downloading the extension.  

To Save As a PDF: 

¶ Click the Microsoft Office Button. 

¶ Select Save As PDF. The Save As dialog box will appear. 

 

¶ Select the location you wish to save the document using the drop-down menu. 

¶ Enter a name for the document. 

¶ Click the Publish button. 

Proofing Features 

 



Worried about making mistakes when you type? Don't be. Word provides you with 

several proofing features that will help you produce professional, error-free documents. 

In this lesson you will learn about the various proofing features, including the Spelling 

and Grammar tool. 

Various Line Colors: 
By default, Word automatically checks your document for spelling and grammar errors. 

These errors are indicated by colored wavy lines.  

¶ The blue line indicates a contextual spelling error.  

o A contextual spelling error is when an incorrect spelling of a word is 

chosen. For example, if I write, "Deer Mr. Theodore," at the beginning of 

a letter, deer is a contextual spelling error because I should have used 

dear. Deer is spelled correctly, but it is used incorrectly in this letter. 

¶ The red line indicates a misspelled word.  

¶ The green line indicates a grammar error. 

 
 

To Use the Spelling Check Feature: 

¶ Right-click the underlined word. A menu will appear.  



¶ Select the correct spelling of the word from the listed suggestions.  

¶ Left-click your mouse on the word. It will appear in the document.  

 
 

You can choose to Ignore an underlined word, add it to the dictionary , or go to Spelling 

dialog box.  

To Use the Grammar Check Feature: 
¶ Right-click the underlined word. A menu will appear.  

¶ Select the correct word from the listed suggestions.  

¶ Left-click your mouse on the word. It will appear in the document. 

 



You can also choose to Ignore an underlined word, go to Grammar  dialog box, or find 

out more information  about the word and its usage.  

You can also wait and run the spelling and grammar check after completing the 

document. Click the Spelling & Grammar command on the Review tab. 

Working with Hyperlinks  

 

A hyperlink  is a piece of text or an image in an electronic document that can connect 

readers to another portion of the document or a different web page. In addition, a 

hyperlink can be used to connect to and open an email client window.  

Ever noticed the active links on web pages that allow you to jump from one page to 

another? You just used one to open this lesson. These are hyperlinks. You can use these 

in electronic versions of your Word documents just like you do in web pages. In this 

lesson you will learn the basics of working with hyperlinks, including how to insert and 

remove them in your Word document. 

To Insert a Hyperlink: 
¶ Select the text or image you would like to make a hyperlink .  

¶ Select the Insert tab.  

¶ Click Hyperlink  in the Links group. The Insert Hyperlink dialog box appears. If 

you selected text, the words will appear in the Text to display: field at the top.  



¶ Type the address you would like to link to in the Address: field. 

 

¶ Click OK . The text or image you selected will now be a hyperlink. 

You can also insert a hyperlink that links to another portion of the same document. 

Word recognizes many emails and web addresses as you type and will format them as 

hyperlinks automatically after you press the Enter key or spacebar. 

To Remove a Hyperlink: 
¶ Select the hyperlink  you would like to deactivate. 

 

¶ Select the Insert tab.  

¶ Click Hyperlink  in the Links group. The Edit Hyperlink dialog box appears.  



 

¶ Click Remove Link. 

Printing Documents 

 

Once you complete your document, you may want to print  it for various reasons. This 

lesson covers the three basic features of printing in Word including Print Preview, 

Quick Print , and traditional Print . 

Printing  
To Preview the Document Before Printing: 
¶ Click the Microsoft Office Button.  

¶ Select Print  Print Preview. The document opens in Print Preview format. 



 
¶ Click Print  to print the document or Close Print Preview to exit the preview 

format and make changes to the document. 

In Print Preview format , you can do many tasks including:  

¶ Modify the margins  

¶ Change page orientation  

¶ Change the page size  

¶ Zoom in and out to view various parts of the document  

¶ View multiple pages  

¶ Access Word Options to change many Word settings  

¶ And more  

To Print: 
¶ Click the Microsoft Office Button.  

¶ Select Print Print . The Print dialog box appears.  

¶ Select the pages you would like to print -- either all pages or a range of pages.  

¶ Select the number of copies.  



¶ Check the Collate box if you are printing multiple copies of a multi-page 

document.  

¶ Select a printer from the drop-down list. 

 
¶ Click OK. 

To Print via Quick Print: 

¶ Click the Microsoft Office Button.  

¶ Select Print Quick Print .  

¶ The document automatically prints to the default printer. 

 

Introduction to Microsoft PowerPoint 2007 
 

PowerPoint 2007 is the presentation graphics software in the Microsoft 2007 Office 

Suite. With PowerPoint, you can use its easy-to-use predefined layouts, themes, or 

templates to create dynamic and professional presentations. 

Setting up Your PowerPoint Environment 



 

Before you begin creating presentations in PowerPoint, you may want to set up your 

PowerPoint environment and become familiar with a few key tasks such as how to 

minimize and maximize the Ribbon, configure the Quick Access toolbar, switch views, 

and access your PowerPoint options. 

Exploring the PowerPoint Window 
When you open PowerPoint, a new presentation is created and a blank slide appears in 

the PowerPoint window. The slide has placeholders for you to add a title and subtitle. 

The tabbed Ribbon menu system is how you access the various PowerPoint commands. 

If you have used previous versions of PowerPoint, the Ribbon system replaces the 

traditional menus. Above the Ribbon in the upper-left corner is the Microsoft Office 

Button. From here, you can access important options such as New, Save, Save As, and 

Print. By default the Quick Access Toolbar is pinned next to the Microsoft Office 

Button, and includes commands such as Undo and Redo. 

On the left side of the window, you will see a task pane with slides and outline tabs, 

which appears by default. On the bottom, right area of the screen you will find View 

commands (Normal, Slide Sorter, and Slide Show), and the zoom tool. 



 

To Zoom In and Out: 

¶ Locate the zoom bar in the bottom, right corner. 

¶ Click the slider and drag it to the right to zoom in and to the left to zoom out. 

 
 

 

 

To Change Views 

¶ Locate the View options in the bottom, right corner. The View options are 

Normal, Slide Sorter, and Slide Show. 



¶ Click an option to select it. 

 
 

The default is Normal View. 

The Quick Access Toolbar 
The Save, Undo, and Redo commands appear by default on the Quick Access toolbar. 

You may wish to add other commands to make using specific PowerPoint features more 

convenient for you. 

To Add Commands to the Quick Access Toolbar: 
¶ Click the arrow  to the right of the Quick Access toolbar.  

¶ Select the command you wish to add from the drop-down list. It will appear in 

the Quick Access toolbar. 

 
 

OR 

¶ Select More Commands from the menu and a dialog box appears. 

¶ Select the command you wish to add. 

¶ Click the Add button. 

¶ Click OK .  



 

The Ribbon 
The new, tabbed Ribbon system replaces traditional menus in PowerPoint 2007. It is 

designed to be responsive to your current task and easy to use; however, you can choose 

to minimize the Ribbon if you would prefer to use different menus or keyboard 

shortcuts. 

To Minimize and Maximize the Ribbon: 
¶ Click the drop-down arrow next to the Quick Access toolbar.  

¶ Select Minimize Ribbon  from the list. The Ribbon disappears.  

¶ To maximize the ribbon, click the arrow again and select Minimize the Ribbon 

to toggle the feature off.  

 

You can also minimize and maximize the Ribbon by right-clicking anywhere in the 

Ribbon and selecting Minim ize the Ribbon in the menu that appears.  

 



The Microsoft Office Button 

The Microsoft Office Button  appears at the top of the PowerPoint window. When you 

click the button, a menu appears. From this menu you can create a new presentation, open 

existing files, save files in a variety of ways, and print. You can also add security 

features, send, publish, and close files.  

 
 

To Change the Default PowerPoint Options: 

¶ Click the PowerPoint Options button. A dialog box will appear.  

¶ Select a category on the left to access different PowerPoint options. 



¶ Modify any of the default settings. For example, if you want to change the color 

scheme of the PowerPoint window, click the color scheme drop-down menu in 

the Popular section and choose an option. In this example, we choose Black. 

 
 

¶ Click OK and the changes will be applied. In this example, the PowerPoint 

window color scheme is now Black. 

 



As you learn more about PowerPoint and become proficient at using it, you may want to 

modify some of the settings. As a beginning user, it is usually best to leave the default 

settings. 

Presentation Basics 

 

PowerPoint includes all the features you need to produce professional-looking 

presentations. When you create a PowerPoint presentation, it is made up of a series of 

slides. The slides contain the information you want to communicate with your audience. 

This information can include text, pictures, charts, video, sound, and more.  

Before you begin adding information to slides, you need to know the basics of working 

with slides. In this lesson you will learn how to start a new presentation, insert new 

slides, modify a layout, move and copy slides, how placeholders work, as well as how to 

save your presentation. 

Creating New Presentations 

When you open PowerPoint from the Start menu or from an icon on your desktop, a new 

presentation with one slide appears by default. You can also create a new presentation 

while PowerPoint is already open. 

¶ Click the Microsoft Office Button  and choose New from the menu.  



 

The New Presentation dialog box will appear. Blank presentation is selected by default. 

 

 

¶ Click Create, and a new presentation will open in the PowerPoint window.  

The default slide that appears when you create a new presentation is a Title Slide layout. 

 

 

 

 

 



Slide Basics 

About the Slides 

Slides contain placeholders, or areas on a slide that are enclosed by dotted borders. 

Placeholders can contain many different items including text, pictures, and charts. Some 

placeholders have placeholder text, or text that you can replace, and thumbnail -sized 

icons that represent specific commands such as Insert Picture, Insert Chart, and Insert 

Clip Art. Hover over each icon to see the type of information you can insert. 

 

About Slide Layouts 

The placeholders are arranged in different layouts that you can select when you insert a 

new slide or that can be applied to existing slides. In the example above, the layout is 

called Title and Content and includes title and content placeholders.  

A slide layout arranges your slide content. Layouts contain different types of 

placeholders that you can use depending on what information you want to include in your 

presentation. Each layout has a descriptive name, but the image of the layout shows you 

how the placeholders are arranged on the slide.  



To Insert Text into a Placeholder: 

¶ Click inside the placeholder. The placeholder text will disappear and the 

insertion point will appear. 

¶ Type your text once the insertion point is visible.  

¶ Click outside the placeholder when you have entered all your text into the 

placeholder.  

When you enter text or use the icons to insert items, the placeholder text and/or icons 

disappear as soon as you start typing. 

To Insert a New Slide: 

¶ Click the New Slide command in the Slides group on the Home tab. A menu will 

appear with your slide layout options.  

 
 

¶ Click the slide you want to insert. A new slide with the chosen layout will appear 

in the center of the PowerPoint window and in the pane on the left. 

To Change the Layout of an Existing Slide: 

¶ Select the slide you wish to change. 



¶ Click the Layout command in the Slides group on the Home tab. A menu appears 

with your options.  

 
 

¶ Click an option to select it. The slide will change in the presentation. 

 
 

Working with Slides 

To Copy and Paste a Slide: 

¶ Select the slide you wish to copy. 

¶ Click the Copy command on the Home tab.  



 

¶ Click inside the slides tab on the left task pane. A horizontal insertion point will 

appear. 

¶ Move the insertion point to the location you want the copy of the slide to appear. 

 

¶ Click the Paste command on the Home tab. The copied slide will appear.  



 

You can use the keyboard shortcut Ctrl  and C to copy the slide and Ctrl  and V to paste 

it. 

To Delete a Slide: 
¶ Select the slide you wish to delete. 

¶ Click the Delete command in the Slides group on the Home tab. 

 
You can also delete a slide by pressing the Delete key on your keyboard. 

To Move a Slide: 
¶ Select the slide you wish to move on the slides tab in the left task pane. 

¶ Click and drag the slide to a new location. The insertion point will appear. 

¶ Release the mouse button. The slide will appear in the new location. 

Using Different Views from the PowerPoint Window 
In the bottom, right corner of the PowerPoint window are three view commands. From 

here, you can change the view to Normal, Slide Sorter, or Slide Show view by just 

clicking a command. 

 



Normal is the default view and where you will create and edit your slides in the center 

slide pane and all the slides will appear on the slides tab in the left task pane.  

Slide Sorter is a view of your slides in thumbnail form. The slides are presented 

horizontally, which allows you to see more slides at a time. 

Slide Show view fills the computer screen with your presentation so you can see how the 

presentation will appear to the audience.  

Saving Your Presentation 
If you are saving a document for the first time, you will need to use the Save As 

command; however, if you have already saved a presentation, you can use the Save 

command.  

To Use the Save As Command: 
¶ Click the Microsoft Office Button .  

¶ Select Save As. A menu will appear. 

¶ Select the type of file you would like to save the presentation as. The two most 

commonly used file types are: 

o PowerPoint Presentation -- This saves the presentation as a 2007 

PowerPoint file. Only users with PowerPoint 2007, or the compatibility 

pack, can view the file without possibly losing some of the formatting. 

o PowerPoint 97-2003 Presentation -- This saves the presentation so that it 

is compatible with some previous versions of Excel. If you will be sending 

the presentation to someone that does not have Office 2007, you should 

use this file type. 

 



 

¶ The Save As dialog box will appear. Select the location you wish to save the 

document using the drop-down menu.  

 
 

¶ Enter a name for the document. 

¶ Click the Save button. 

To Use the Save Command: 

¶ Click the Microsoft Office Button .  

¶ Select Save from the menu. 

Using the Save command saves the document in its current location using the same file 

name. 



 

 

CHAPTER III  

 

 

Creative ways to integrate technology into the curriculum 

 

 Learning through projects with technology challenges the student to be engaged 

in their learning.  When content is relevant to the students lives, many opportunities to 

learn are created when using technology. There are many creative ways to integrate 

technology into the curriculum. For more information on the subject, including sample 

assignments go to http://de-learning.com (McCall, 2009). 

 It is estimated that American youth spend 12,000 hours in school in their k-12 

lives. Students learn by interacting and watching those who teach them and those who 

discipline them (Curwin & Mendler, 1998). Learning to be culturally responsive with 

respect to the students, gives educators the understanding of how the students live and 

learn. Culturally responsive teaching incorporates studentsô cultural background, ethnic 

history and current interests into daily instruction. By making connections with studentsô 

backgrounds, interests, and experiences educators can be capable of reaching this 

population of students by simply learning about the students lives outside of their 

classrooms.  

 With the help of free resources available on the Internet, this researcher has 

created various assignments that at-risk students have responded to.  The use of graphic 

organizers allows students the opportunity to make sense of assignments through 

graphically visualizing the parts of a written project, or graphically adding content to 

their writing, both of which can help them with problem solving. The following 

assignment was developed with the at risk youth in mind.  

http://de-learning.com/


 

 

Graphic Organizers 

 We as educators sometimes function as both parent and teacher to at risk youth. 

One assignment that is popular with my students, I call ñInfluences.ò The students are 

asked to think about characters that have not been born, either good or bad, (e.g. 

Mickey Mouse or Chef from South Park), that have influenced their lives. The 

assignment allows the students to think outside the box, to see how such things as the 

media, family, friends, career choice, and religious beliefs affect their lives and leave 

impressions on them. With the use of a graphic organizer, students learn to outline, 

research, and complete projects effectively. 

Influences 

Primary Subject Area: Computer Class 

Grade Level: 9-12 

Objectives: 

Students will be able to:  

¶ Add text, photos, and Web links to an Inspiration document 

¶ Search for photos using a Web browser 

¶ Save photos on their computer to insert into their document 

¶ Save their document, in their folder, located in the studentsô server 

¶ Export the document to a JPEG file 

¶ Print assignment for assessment 



¶ Convert the Inspiration document, by choosing the ñtransferò icon, to a Word 

document and write a brief description that explains how each character has 

affected their lives either good or bad. 

Massachusetts Technology Standards Addressed: 

 

¶ 1.36 Run multiple applications simultaneously, alternating among them. 

¶ 1.38 Identify and use methods for transferring, and converting graphic files. Use 

different graphic file formats where appropriate e.g. PICT, TIFF, JPEG. 

¶ 1.53 Know how to select and use search engines. Understand the difference 

between search engines. 

¶ 3.16 Collect, organize, analyze, and graphically present data using concept-

mapping tools. 

¶ 3.17 Import graphics, photos, and other media into report or presentation, citing 

sources appropriately. 

Materials Needed: 

 

PC with Inspiration software 

Microsoft Word 

Browser (e.g. Explorer, Mozilla Firefox)  

Printer 

Lesson Procedures: 

 

1. The students will brainstorm thinking about characters that have influenced their 

lives. These can be either good or bad. They must be characters that are fictional, 

cultural or media-based. They should select three ñgoodò and ñthreeò bad 

characters.  



2. Each student will insert his/her answers into an Inspiration document, creating a 

graphic map, linking the chosen characters together. 

3. Using a web browser, the students will find photos of their characters, and save 

them on their computer to insert into the document. 

4. The students will than distinguish if each characterôs influence was good or bad 

for them. They will create ñgoodò or ñbadò bubbles, and link their character to the 

appropriate bubble. 

5. The students will use the Internet to search for biographical information on their 

characters, and save the Web links in their Favorite Folders. Using these Web 

sites saved in their Favorites Folder, the students will insert web-links to their 

characters, using the saved URL.  

6. The students will than type a descriptive phrase to explain how they were 

influenced by each character they have chosen. 

7. The students will use the ñarrangeò icon to set up their final project to be printed 

for assessment.  

Assessment: Assessment of the final project must meet all standards addressed. Did the 

students add text, graphics and Web links to their presentation? The studentôs final 

product will also be assessed in the areas of originality, research tools used, Web linking, 

structure, and presentation. 

 

 



Template ï 

Most 

Influential 

People /

Characters- 

Who Neve r 

Lived

Archie Bunker

Mickey  

Mouse
Marlboro Man

Daisy 

Duke

Captain 

Kangaroo

The Shark for Jaws

Fred The 

Baker-"Time 

to make the  

Donuts" 

Lady Luck

 

 

 

Steps 3, 4, 5 

 

Most 

Influential 

People /

Characters- 

Who Never 

Lived

Archie Bunker

Mickey  Mouse

Marlboro Man

Daisy 

Duke

Captain Kangaroo

The Shark for Jaws

Fred The 

Baker-"Tim e to 

m ake the 

Donuts" 

Lady Luck

G OOD
BAD

 

 

 

 

 



 

Step 6 

Most 

Influential 

People /

Characters- 

Who Never 

Lived

Archie Bunker

Mickey Mouse

Marlboro Man

Daisy 

Duke

The Shark for Jaws

Fred The 

Baker-"Time to 

make the 

Donuts" 

Lady Luck

GOOD
BAD

Smoking 

is Cool

Bigot

Fear of  

Water

Changed 

the way 

women 

dress

Gave Us 

Hope

Influenced 

my coffee & 

donut 

intake 

Allowed 

me to 

imagine

Barbie

Beauty i s 

skin  

deep

 

 

 

 

Step 7 

Most 

Influential 

People /

Characters- 

Who Never 

Lived

Lady Luck Archie Bunker

Mickey 

Mouse

Marlboro Man

The Shark for Jaws

Captain 

Kangaroo

Fred The 

Baker-"Time 

to make the 

Donuts" 

Daisy 

Duke

Good 

Influence

Bad 

Influence

 



Webquests 

 Problem based learning allows students to strive to find meaningful challenges to 

learning, which results from working with problems. Using technology as a tool for 

educating these students can lead to improved learning and success. According to Bernie 

Dodge (2007), a WebQuest is an inquiry-oriented lesson format in which most or all the 

information that learners work with comes from the Web. A WebQuest is a self-directed 

assignment using the Internet which allows the students to learn at their own pace, using 

prior knowledge to combine past experiences and current understandings. 

 The following Webquest was created using Microsoft Power Point software to 

help students think about transitioning into adult life.  Making the transition from high 

school into adult life can be the most important function of high school for at-risk youth. 

Transitional goals can be not only post secondary education, but also vocational training, 

job coaching, independent living, and continued services that all students with disabilities 

are entitled to by law.   

 The Internet has quickly become one of the most popular job search methods used 

today. It connects students to the world and allows students that have not yet considered 

career options the opportunity to research possible careers easily. The Internet has 

changed the way we search for jobs; it truly allows for more potentially equal 

opportunities. Research has shown that success is possible if one has goals. The 

following screen shots are from a Webquest created with post-secondary life in mind. For 

more information on the subject, go to http://de-learning.com/webquest.htm (McCall, 

2009). 

 

 

 

http://de-learning.com/webquest.htm


 

Job Search Webquest 

 

 
 

Introduction  

 

 


